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Control Panel ﬂflﬂjﬂf’w’ﬁ
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| Brightness - User Box Fax / Scan Copy Reset
8 \ L{.Al:t:ee..'.ihility “f] [i [i]J :vJ / _5
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33 BEE  Proof Copy Interrup
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MNO.

Enlarge Display E E 6]
= — =  Start .
Guidance 8] (e
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1. Touch Pen  #iAz=T

2. Touch Panel &g ﬂiﬁ

3. Main Power indicator %\Tﬁjﬁ?ﬁ 851

4. Sub power switch ;ﬁ'J?:ﬁ’ﬁF'ﬁJEﬁ

5. Functionkey =i

6. Data indicator ©vf] AR

7. Keypad gy 58

8. Brightness Adjustment Dial ﬁﬁ%jﬁ@%ﬁ%
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IKONICA MINOLTA

Account Login §|§E!E| “F’T E

** If device with account track function, please follow the below steps
SRR AR o s R T R S
** |f device with user authentication function, please refer to page 4
Y RE R b o i S
Input account password and touch [Access] to login

#ETX ﬁﬂﬁﬂ}fﬁﬁ,ﬂ 1% [Access]) ﬁ' 5

I ®Enter Account Name and password, and then
touch [Loginl or press the [Access] key.

HSeE  Istatus

Account Name ‘

§ 12/24/2009  09:39
Toner Vel y

Y Press [Access] twice to logout Access

BTN
o (ORFIE [Access] 2% @
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IKONICA MINOLTA

User Authentication Login @E'J?{ ,H%\& 3

** |f device with user authentication function, please follow the below steps

*EPI=IEE I ™ gf’i;ﬁ,ﬁﬁt ; ﬁ%ﬁgu;‘k HER \’° S

** If device with account track function, please refer

**-[/Du[ el Sﬁ %*%I?jfg“‘” ’ F%E

Touch [Public User Access] to login Fax/Scan function

3 GRSl D IR RN Rl s

Touch [User Name List] to choose the user name, then touch [OK]

B LIDEH EPaspT] 2 H 67 A (]

Enter the password, then touch [OK] and [Login]
(R AN GIETED Rty G

| _ ®Enter a login user name and password, and then touch
. . [Loginl or press [Access].

Reee  IStatus
User Name

User Name List /

Password

[

(T

Job Details

[

e

|8

LTI

12/24/2009 09:37
Toner Monor,

* Press [Access] twice to logout Access
(tmo |
o (GER)iHE [Access] 52 % (@\
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IKONICA MINOLTA

Copy Function g/H[=/g<

[Density/Background JEL %7, /¥, &)

1. Touch [Density] — the print image can be adjusted, [Lighter] or [Darker] is touched once, the density is
lightened or darkened by one level.

HODRIRR] FIREDTY (T VEaRE

2. Touch [Background Removal] — the density of the background color of the document can be adjusted, [Light]
or [Dark] is touched once, the background density is lightened or darkened by one level. [Paper
Discoloration Adj] can make adjustment for background removal in copying.

[Bleed Removal] can make adjustment for thin paper in copying

% 5’%‘;&] U TRIFOT R

I Basic loriginal Setting| | oOriginal Type | [ Application
= -

Density Backaround

JooonEmemnp

Background Removal Level

(ooOEenEmnp
coloration Add

o

| Bleed Removal

5 The essentials of imaging
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IKONICA MINOLTA

Copy Function g/H[=/g<
[Paper size and paper type setting 5%3=5 0] ﬁlmf{rjr%@

Ready to copy. Copies: 1

[original setting| [ original Tvee | | apelication |

| Bsmitid || Bl zon  J§ hemies ]
1. Touch [Basic], Touch [Paper] . J - ' = — :
AELRRE RS 3 Bk

gl O |
e |

2. Select By-pass Tray

L Bl D

3. Touch [Change Tray Settings]
E&, [ﬁﬁﬁgﬁﬁllﬁ}'@ 111;3:”1:

4. Select Paper T ——
. Select Paper Type :
pwsiud i SRR B K|
IE AT
o | -__
5. Touch [Standard Size] to select size T it | micktr
FINI R
iz Mmoo |
Touch [Custom Size] to input (Length) [X] and

(width) [Y] , e.g. 90mm, please input 0900

13/11/2006 20:25

100%

(If the paper size is stored , touch [Store] , then choose Memoryl -5)

PR ] i S XPTROR Y] T80 90mm i 0900
(P e o] IR FR T

Memoryl -5) - .
¢ 2 Y
6. Touch [OK] | ¥
H#[OK] ¥
X
139.7 - 457.2 Y
%
Y
ESEXEEE
0.0 - 3111 Y
Store |

6 The essentials of imaging
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IKONICA MINOLTA
Copy Function EV,E{J:‘#E}:
[Zoom ﬁﬁ}]
1. Touch [Basic], Touch [Zoom] Ready to copv. Copies:

1

FELARE - R

[or1atnal Settina] [ orisinal Tree | [ Aeplication |
T (-

S T m m0 -
=

2. Select fixed zoom size

g. - /A3 » A4 default zoom ratio is

0.707

: ) P Fised Foom User Presel Foom
AR R 121.4% | 129.6% | 1545
S . ESl | 1214x (12.6% -" | aon.on |
be S = IR A T & Blax14 | Blax1l |SkxBl | 200.0% —
T o IR || s11x17 | »11x17 | ~Bhx14
I A3 » A4 ?@Vﬂh 0.707 | 200.0n
= = | 785% | 77.2% | 64.7%
8t 1117, | 11x17. | S0.0% | 50.0%
Reduce =Blax]l [ =8hx1l4 | =8k

llf dgifh

3. TouchE to change zoom ratio
(S oy s s e g
F

1071442010
ulediTil el

4. Touch [Manual] , using the keypad , type in the desired zoom ratio, then touch [OK]
=g i BT HOK]

7 The essentials of imaging



Copy Function g/H[=/g<
[Sort/Group 75 ! /;’};g]

1. Touch [Finishing]

R

2. Touch [Sort]or[Group]
[ YR [EEE]

3. Press [Start] to Copy
YR E P’j?i& >y [Start] B

[Offset 75 F1/53 %]

1.  Touch [Finishing]
i)

2. Select [Yes] in Offset option
o A FEIE R H TR

O

IKONICA MINOLTA

Ready 1o copy.

Drenesd by -
Backaround

Density

INEEEFEDEO0

Copies:

[original setting] [ original Tyre | [ Application |

Fold/Bind [ /]

3. Press [Start] to Copy I . ! .
H[Start] fH] ' '
*1f no finisher is installed printed copies are sorted in crisscross pattern 1 4

Y2 E lﬂﬁ:

EIE 77 R

*1f a finisher is installed the copier is stacked on top of each other with each set shifted to separate it

il :L%f ’E¢’$J ERAEaR

8 The essentials of imaging
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IKONICA MINOLTA

Copy Function E/H[ /5=
7 LBJ
* (Optional Function) (#4544 %1 ™ Z1)

[Staple ?ﬁi]
1.  Touch [Finishing] Ready 10 copy.
I Basic

DEnssi by s
Backaraund

Copies:

2. Select [Corner] or [2 position] in staple Dems ity

EFHERL I [FED (2 )

... ] . | Corner Starle
3. Touch [Position Setting] to desired staple Top Letl

position f Finishing . Bl Serdrate Scan | huto Rotate OFF

RS

4. Touch [Start] to Copy
o [Start] gYHIHE

|
|
|
[}
[}
[}
|
|
|
[}
[}
[}
|
|

[Punch 73] —

1. Touch [Finishing]
EQN RN AL )

2. Select [2 Hole] or [4 Hole] in punch
T}F%T%TEJE "HER[27] B[4

Fold/Bind

3. Touch [Position Setting]
H [E‘El‘?‘i—] i%uj;c%;ﬁ;‘u@?f

4. Touch [Start] to Copy
fF[Start] sYHIGE

9 The essentials of imaging
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IKONICA MINOLTA

Copy Function E/H[)/g<
7 LB
* (Optional Function) (#4574 % 1) ™ Z1)

Copies:

Ready 1o copy.

[Fold/Bind E’I%{‘/%}i?gi] [original settina] [ original tvpe | [ fpplication |

Denss i by -
Backaraund

Dens ity

1. Touch [Finishing] AIEDENEIE0

HTEIR]

Corner Staple
Top Lefl

2. Select [Yes] in [Fold/Bind] T Finshim || Sebarate Sean || uto Rotate 0T
i AT Bl TYes T |

v
3. Touch [Half-Fold], [Center Staple & Fold] or njry
[Tri-Fold]

£, [FREEST] 9 [ #]

Finishing > Fold/Bind
[ Yes Ho )

| Hal f-Fold |Center Staple & Fold | Tri-Fold

13/11/2006
Henory

18:59
1003

Half-Fold EAT}F?} Center Staple & Fold f[If ? Tri-Fold = E’f

#-0 || |[5- o

10 The essentials of imaging



IKONICA MINOLTA
Copy Function E%HHJEI» Ready 10 COPY. Copies:
[original Setting] [ original Type | [ meplication ||

[Combine 7 F",] RS

1.  Touch [Basic], Touch[Duplex/Combine] e
HE AR, SRR A]
2. Touch [2in 1] or [4in 1/ 8 in 1] to reduce the
. .. . Corner Staple
size from 2 / 4 / 8 sheets originals into 1 sheet Top Lefl
of copy

B [2in1] 5 [4in1/8in 1] #1fq/pH/ 7 32
R - 3=

loriginal setting| [ original Type | | application

| T -] o |

Original » Copy Combine
IEETRRETT N B 1-sided > 7-5ied NI T

[Duplex £51] [ o-sided > 2-Sided 3] g
_ _ Binding Position [ zim

1. Touch [Basic], Touch[Duplex/Combine]
BRI, HISR A) -

a. | 1-sided > 2- sided| Single-sided Original to Double-sided Copy
FIEVRUy H HI [L-sided > 2-sided BTE1 > i

e[

b. | 2-sided >1-sided| Double-sided Original to Single-sided Copy
S }%ﬁf,!.‘ Ffpl 14 2-sided >1-sided| S > HIE

9+

C. \2-sided >2-sided\ Double-sided Original to Double-sided Copy
STVRG HI STTH Rosided >2-sided 1 > S

—| 1212

11 The essentials of imaging
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IKONICA MINOLTA

Copy Function §/H[=1'f=

[Original Type ’“}%’lﬁﬂj?fpﬁfﬂ]

Touch [Original Type]
H IR

Select [Text], [Text/Photo],
[Photo],[Map], [Dot Matrix Original] or
[Copied Pap]

S R ]

Ready 1o copy.
' Basic | [[original setting [ application ||

Original Type

=
—

4

)

Copied Paper

O

TextPhoto

Photo | Dot Watrix Original

Text. Enhancement |

IEEEEEEE000 |,

4 I G1055Y

Touch [Text Enhancement] — select the reproduction quality of text when a copying document consisting of
text that overlaps images such as illustrations or graphs

[ ] %‘ﬂﬁiﬁﬁd PP

Touch [Glossy] - select this setting when copying images with a glossy finish

& U] BrEA sl

[Proof Copy £V H[FHET]

1.

12

Press [Proof Copy] twice to preview
o fmlﬁgipfjﬁ%ig%z » $ % [Proof
Copy] & Y H I3

Press [Start] button to start printing or press
[Stop] button to go back and make some
adjustments

H[Start] ’ﬁgr% SIH] - @ [Stop] EiaE Tt
EiRlE

Scanning wi

If the display s anged, [View Finishingl will not be available.

| Preview

Preu. Hext
* Lo - So80

2 gxil D 100. 0%

IJJJ

I]q ’27 2009 ‘IEI 3_
C

The essentials of imaging
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Page Rotation
Rotate current page

Select page{s> 10 rotate 2

(view Finishing] |[ERTEETTY)
View Pages View Status
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IKONICA MINOLTA

Copy Function E{f,EfJ:ﬂJEi:

igi ing JECRE S iR |
[Originals Setting Flﬁr%:\_]

Original Size

| Mixed Original | Z-Folded Original fiuto

1. Touch [Mixed Original] to load originals of
different sizes (A4 or A3) into the ADF and scan RSP
them at a time.

B0 Flﬁﬁ]ﬁfgﬂ?ﬂﬁﬂﬁl 2 R AR
El}ﬁg 7 [ﬂ U?f'lf[

original Direction |

@ N G e SRR

Despeckle

2. Touch [Z-Folded Original] to correctly detect the ;

original size when folded originals are loaded into the ADF
and copied.
FIJ"‘ 7t TR i ; 51/ ,ﬁangr*
#[Z JT’% VRO Z FsE i R Y Eﬂ B E'@I
||

|E¢

3. Touch [Binding Position] to specify the original binding
position (page margin) to prevent the copy from being printed
upside-down when scanning a 2-sided original.

HURORE F 1] 2 EFlr R i)

13/11/2006  18:19

4. Touch [Original Direction] when copying double-sided originals or making double-sided or combined
copies, to specify the direction in which the original is loaded into the Feeder or placed on the Original
Glass.

T%[’F'Lﬁ%‘ﬂ‘fﬁ[ﬂ] SILrh ] mfﬂ JFTT};T:LE JrfFl'

5. Press [Original Size] to specify the original size, the default setting is auto detect

RO ] ROl T STRERLE Pl o

13 The essentials of imaging
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IKONICA MINOLTA

Ready 1o copy.

Copies:

Copy Function §/H[=/=

[Application & | ﬁJF =

_ Basic \0riginal Setting Original Type

fApplication

eet/C er
Enapt;er nsért. 4

Ed it Image Book CODW Repeat

lnage fdjust Booklet

Page Margin

| Stanp/Conposition

Erase y
Save in User Box

Card Shot

12/24/2009

10: '1(1

[Sheet/Cover/Chapter Insert]

AR IS B

Insert another sheet of paper or add a cover page to the paper for copying

TR FIHIRE ™ ) CARIRD I R TR R N
age —

[Edit Image]%@a‘fﬁ%

Invert the contrast or gradation of the original or prints the original in the
mirror image. It also adds a color in the background or adjusts the quality of
a color image. %‘WEI it 1P e 243

Page 17

[Book Copy/Repeat] FIsdl /T

Configure the settings for a book or catalog. An image on a single sheet of
original can be repeatedly copied or divided and enlarged in parts to produce
copies of the respective parts.

WHIFI T BRI T T st RETE R
Page 18 - 19

[Page Margin] FITi2 138

Select the binding margin (blank area) of the paper used for copying.

TR 1 (55
Page 21

[Image Adjust] (& P%frﬁ:

Configure the layout for the image when the paper is larger than the original.
F#’,”Flﬁﬁjp’lﬁ R PR PURRIRES T R F%‘;ﬁzﬂ.@:l BUP| "Fﬁ‘*h =
Page 20

[Booklet] 7J-f]="

Arrange the page order of the scanned original automatically and make
2-sided 2 in 1 copies to produce a page layout for a center bound book, such
as a magazine.
F VS FAEER £S5t B bt pu R ISR IEI =S - % TR

Page 21

[Erase] Jf{fEf®

Erase unnecessary outside portion of the original body text or erase the area
outside the original placed on the Original Glass.

ATFOH It PR E 2 T EE fTE
Page 22

[Stamp/Composition] &&F?Wﬁﬁ‘}

Print the date/time, page number or a stamp printed on copies. This function
also allows you to embed information for preventing unauthorized copying in
adocument.

TERTE P PR E B9 E /R FRp B - -] RIS

Page 23 - 24

[Card Shot] {5

Copy the double-sided and card-size original, for example, insurance card,
driver's license, or business card, on one sheet.

BRI L L R e il 35

Page 26
[Save in User Box] @& Z[ffi%]% | Save the scanned original data in a User Box.
A RO R SRR

Page 26

14
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IKONICA MINOLTA

Copy FunctiongyH|=J/g=
[OHP 494 fFE!] L

1. Touch [Application]
IR ]

2. Touch [Sheet /Cover /Chapter Insert] intreave paper ¥ el
?%’[JTEEJ IFFE l/jﬁ * ﬁ'[ an]

3. Touch [OHP Interleave OHP]
#IF lfﬁiﬁﬁl ]

4. Select the Interleave Paper
SRS TR R

5. Place the Transparency at the bypass tray :
PO oy = 2 S e e -

6. Press [OK]
#[OK]

7. Press [Start]
F[Start]iy 15

[Cover Mode ﬁf:. l] application > Sheet/Cover/Chapter Insert > Cover Sheet

1. Touch [Appllcat|0n] Front Cover Back Cover
R ]
2. Touch [Sheet /Cover /Chapter Insert]

RS RIS ™ )

3. Touch [Cover Mode] o Javer
[

4. Select Print Image at the Front / Back Cover or

Paper s o |

?MF ﬁpl ] Yg E‘{él%\ﬁy Ié‘cﬁpl : Yg E‘{é['%éjypyﬁg [[ELI %ﬂ% VfF[IF %j‘ I Cover Paper

ph\}ﬁ&l&:ﬁ[&h\, . - A4 D - A4 D
5. Press [OK]
# [0K

6. Press [Start]
4 AL D L A4 D
s star --

15 The essentials of imaging
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IKONICA MINOLTA
Copv Fu nCti On E%/H’J:—g,fﬁ: npplication > Insert Sheet > Insert Page Settings
4 W~
[Insert Sheet }F{EJ]
2

1. Touch [Application] :

B[R ] (TN P
2. Touch [Sheet /Cover /Chapter Insert] :

;ti” Hﬁ_ﬁ’l / ﬁr&l/ }_ﬁ k ﬁ [ lﬁﬁ] Application > Sheet/Cover/Chapter Insert > Insert Sheet '
3. Touch [Insert Sheet] ;

H[jﬁfj] 174 Insert Paper
4. Touch [Copy] or [Blank] to set up print image at — - - A4 D

the insert pages or not .

-~ | == EN

P TREHITE [F EEE R pURIEEe 12 e Ry i
5. Key in the page no. of the insert pages then select
which tray has the insert paper
ﬁ? ! E:Jﬁ" L LS #ﬂﬁ AU
6. Press[OK] L 2
# [OK]
7. Press [Start]
¥ [Start]

. e -

Insert Type

[Insert Image £ (5445 * ] HE,,O Q - REPO

1 1
1. Touch [Application]

1 [T,;%\E'JT‘JJH:] fpplication > Sheet/Cover/Chapter Insert > Insert Image

2. Touch [Sheet /Cover /Chapter Insert ]

H [jﬁ‘F’J /ifq‘fel/jﬁ 7 ﬁ[ ﬁﬁ]

3. Touch [Insert Image]

THSE!
4, fegﬁinit]]e page no. of the insert image [P — Jlp— P J P
B i R } """ '
R
6. Press [Start] Qorzr2009  14:15
¥ [Start]

16 The essentials of imaging
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IKONICA MINOLTA

Copy Function §/H[=]f=

[Edit Image 5 (§fEE]

1. Touch [Application] ABCD
e ] ABCD
2. Touch[ Edit Image] ABCD
b TRy gies] ABCD
3. Touch [ Neg. Pos. Reverse] ABcD

R
4. Press [Start]
¥ [Start]
Ready to copy.

[M i rror Image %E, I%Il f%,é] Application > Edit Image > Mirror Inage

1. Touch [Application]
B[R]

2. Touch [Edit Color]
U TRy pies]

3. Touch [Mirror Image]
S ]

12/24/2009  11:16 0K

Hemory 100%

17 The essentials of imaging
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IKONICA MINOLTA

Copy Function §/H[=/E=

[Book Copy %‘{¢ }ﬁﬁﬁ’r] | T

1.

18

Touch [Application] EI
H [T%E'Jﬂlﬁ:] TR [ separation |
Touch [Book Copy / Repeat]

I, =Z] BE
o TE IR ] T
Touch [Book Copy] TR TR

I #

Touch one of the below of options

application > Book Copv/Repeat > Book Copy
[ Yos Ho )

21:03

13/11/2006
H

ERT N H = g

>

[Book Spread] — Copy both pages of a two-page spread original as a one page original

[1 4 5B — $°V RO 4 1] 9T E

[Separation] - Copy the right and left pages of two-page spreads separately in the order of the page
numbers

[5Y8E — BYAPRBHT % TR, 2 S BEBRER (HIFD) ]
[Front] - Copy the front cover, the right and left pages of two-page spreads separately in the order of the
page numbers, and the back cover in this order.

LR — BRI, FIBEIBE S ()
[Front and Back Cover] - Copy the front cover, separate copies of each page in the page spreads and

the back cover in the original page order.

RIS Er] — SCBILEIT PRI S 7 Fr, SR

Open and place the book at the top right of the original glass and press [Start]

feIsh B S ) § [Start]
Until you have scan all the original you can press [Finish] @ N & SN
E[%?ﬂﬁ*{%ﬁi?} % » $¥ [Finish] | ‘_T et
Press the [Start] to print — —
FI#F [Start] ] ]

®

ATT T T 1
1
|

The essentials of imaging
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IKONICA MINOLTA
Copy Function g/H|Z)/g<
- LB
ABC
= 7 - ABC _ _
[Image Repeat | [3EI ] Ny ABC With Marain
Oriainal
)
ABC AB(
1. Touch [Application] ABCAB(| Without Marain
e ) ARE ARE
2. Touch [Book Copy / Repeat]
PRI ]
3. Touch [Image Repeat]
[ R _
4. Touch [With Margin] or [Without Margin] == ===
LR ORI
5. Touch [Set Range] [ Bs0 B B5c
R “ 5o M Aso
»  Select standard size B6 D Ab D
SRR o NS
»  Touch[ Custom Size] to enter the original size, touch [X] to key in the Width of the original, touch [Y]
to key in the Height of original
BOEFRS] X TR T Y]
6. Press [OK]
7 [OK] |
7. Press [Start] Scan Range
v [
e e
Ml cation > Set Ranos > Cestom Size -
13/11/2006 | o |
139.7 - 457.2
|T 297.0 nn
90.0 - 3111
19 The essentials of imaging
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IKONICA MINOLTA
- - > >
Copy Function g/H1-1"g-
L
Hargin Position ndjust Yalue

[Page Margin FIF12F 13]

1371172006 21:23
Henor:

1. Touch [Application]
B[P 2]

2. Touch [Page Margin]
i [FEpvE ]

1007

___ m |
0.1 - 20.0
= E=

Original Direction

@

0K

) [

3. Select the margin position [Top],[Left] or[Right] —

R AR g M B IS e )
4.  Setup the width of the margin by Key pad or [+] /

[ - ] button

PRy 41/ 0-] R

Wil -

[Top]

5. Press [OK] BB
# [OK]

6. Press [Start] e
¥ [Start]

[Image Adjust F; (& F%jf&‘]

The original image will be copied on to
selected paper according to settings.

1. Touch [Application]
P ] i
2. Touch [Image Adjust] “[m]
e @%EYZ] | centering |
3. Touch [Centerlng]
Fr S [ E  FIR]
4. Press [OK]
# [OK]
5. PreSS [Start] 12/24/2["]9 11: 2'?
f# [Start]

20

ABCD
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IKONICA MINOLTA

Copy Function §/H[=J/E=

[BOOklet ’J‘ -PIJ__J’] Application > Booklet I
L= (T
1. Touch [Application] Fold/Bind

H’[’%\E'leﬁ:] I@El_#ﬁl%rll ‘l{.jﬁﬁ%y | Center Staple & Fold |

2. Touch [Booklet] - # _, | Half-fold |
BRI - e

3. Select [Left Bind] / [Right Bind] r P ——
[EH =R [T ] gutB Eerer

4. Select[Center Staple & fold] or [Half-fold] s
S [IIRISET SR 5 (S —

(Optional Parts is needed)
(G 21 SN S D ey i 9
5. Press [Paper] to select the output paper
6. Press [Cover Sheet] to insert cover Half-Fold %ﬁﬁ
sheet

 comnc o | (g Dol || [ 7

7 [OK]
8. Press [Start]
¥ [Start]

7 )
)

04/27/2009
Memory

15: 42
100

Center Staple & Fold [ If#] Ff’

21 The essentials of imaging



Copy Function §/H[=J/E=

[Frame Erase 32A=if]=]

1. Touch [Application]
R bgs]
2. Touch [Erase]
B RE]
3. Touch [Frame Erase]
R
4.  Select the edge and input the width
E%%‘HTB@%@E@@fﬁ[’“%ﬁ@
5. Touch[OK]
" [OK]
6. Press [Start]
¥ [Start]

O

IKONICA MINOLTA

Application > Erase > Frame Erase

C w e
Frane
gf:::.i ’1 . m
Top T -y
= ES
Frame Riaht,
— -

o |

D202/ 2008
MEmOFY

10:10
1002

[Non-Image Area Erase [ i Bk ][]

1 Touch [Application]
B[R g

2  Touch [Erase]
 [MIR=]

3 Touch [Non-Image Area Erase]
 [PBY e IsafiE]

4 Touch [OK]
# [OK]
5  Press [Start]
¥ [Start]

22

Application > Erase i

L]

Erane JREE ST

D4/27/2009
Memory

15: 44
100%

The essentials of imaging




O

IKONICA MINOLTA

Copy Function g/H[=/g<

[Stamp Composition- Date/Time %BFEW%E& -F 1A/ R

1. Touch [Application]

%—5 [T‘%Eljﬁjﬁ:] Select desired datestime type. Copies:

2. Touch [Stamp/Composition] — — -
Application > Stamp/Composition > Date/Time
pEE = [@F:g/’f%’%‘] [ Ves e
3. Touch [Date /Tlme] Date Format Time Format Pages
v LR _vom | s ]
4. Touch [Print Position] to set up the position of : : =
the date and ime —
F IR it O T P _
5. Touch [Text Size] to set up the size of the date | 2007 | | tone  [EIPrint Position
and time __Top Left
B[R] R T R ot v |
6. Touch [All PagesF] to print date/time in whole Tt Dehals
printout 12/26/2009  11:42 [IT:
ol G I i o i 5 1
[ el

7. Touch [1* Page Only] to print date/time on the 1% page only
S BRG] P ST SRR CHIR]E
8. Touch [OK], then press [Start]

f# [OK] - F|fF[Start]

[Stamp Composition- Page# F! ﬁ}f%]

®Use the kEYFﬂd I,I) gnT:er T:he stquing page Copies:
1. Touch [Application] Press T4 to Suiteh betucon  and e
e [T‘%E'Jﬁjﬁt] Application > Stamp/Composition > Page Number
2. Touch [Stamp/Composition] [ =
e [@E‘EI/)[%J;&] Riinber® Pa0° Page Number Type
3. Touch [szge Number] H §2%§{ﬁgs"ee“
i [EIR]
4.  Enter the starting no. at [Starting Page Number] ctorting Chapter 1,2, 3
s royr . Py g Print Position
& [FIRVRIRR IR B I
5. Press [Print Position] to change the print 100 - +100 -
)
CEIE AR TS R E LA 7 s ] b R
7 [IIEIRERN] pE e T ][RI g . ok |
6. Press [OK], then press [Start] .

#[OK] - f|¥¥[Start]
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Copy Function g/H[=/g<

[Stamp Composition- Stamp @F&b}%é}-gﬁa]

1. Touch [Application]

Application > Stamp/Composition > Stamp

R Lh] v e

2. Touch [Stamp/Composition]
Y BRG]
3. Touch [Stamp]

Stamp Type/Preset Stamps

W [%9?5'] |
4.  Select desired stamp [ oey Qe | Text Size
YT pm:::;m;
5. Touch [Print Position] to change the print W .
position Black | Top Right |
DRI T e S i HIp o 04/21/2009 15:40 OK

6. Press [OK], then press [Start]
f#IOK] » F#¥[Start]

[Stamp Composition- Overlay &E?ﬁwﬁﬁ‘/ﬁ ]

1. Touch [Application] i
vl

2. Touch [Stamp/Composition]
A [@%’Mﬁ’?‘?]

3. Touch [Overlay]
HET]

4. Press [OK], then press [Start]

f#[OK] - F|¥[Start] original Size
Auto

2:

REPORT

2

Density
100 %

Color |
! 151 Page Only Auto Color

Composition

Transparent

04/27/2009
Hemory

15:56
10074
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Copy Function g/HZ)F=
- LB

[Card Shot {5 ] -t - = B | -
1. Touch [Application] = &

ﬁ, [’T‘%EIJ:‘_’JF]:] aAI'TI'TI -B]‘I\II\I -
2. Touch [Card Shot] g - -

EHA] = -
3. Touch [X] and [Y] and enter the size of the card Al 5 | =

HIX] AT A PN YR EEPE B -p = -p

Af!;—ij;& - -
4, Touch [Zoom] to select the zoom type

[[ﬁ}‘ ] }EJ vfﬁjv ﬂJ = Sel the document on the origindl glass in the direction Thal Copies:
you want it To b2 s d.

»  Full Size = 1:1 (100%)
Auto = automatically selected

based on the size of original | = m

= N5 =11 (100%) S :
E[ B = T[‘LJ%QFLI@ 1= JE[ %};[Jr Original Size Layout

WET WA | lf{ " TopsBotton J
5. Press [Start] . . -
H’ [Start] ‘ Full Fize

010

Ill 'Il'i.r m: 29
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Delete the copy job in the waiting list i |- SRV (&

1.

26

Touch [Job List]
IR ]
Touch [Job Details]
(=]

Select the job you want to delete

e R
Touch [Delete]
 [MIF]

Touch [Yes] and then [OK] to delete printing job
FLRL FfF [OK] fIF (=

(|

Allows you to check jobs currently running or those in queue.

| Mame |Status [Docunent Hame|&EtFed | Gis. | co8 | elete

30 COPY Printing 22:31 1 1

Increasc
Prioritg 4

1ie lease
| Held .0l

13/11./2006 22:32

& fire you sure you want to delete this job?
#18EEa"Sobs : 1
Job Ho. 30

COPY

User Name

Document Hame

Lime 1371172006 22:31

13/11/2006  22:32
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Add Email or Fax S EEIE [ E!

1.

27

Press [Utility/Counter]

¥ [Utility/Counter]

Touch [1. One Touch/User Box Registration]
L EPB AR R ]

Touch [1. Create One Touch Destination]
FVIL. SRR S I3 | 1frops]

Touch [1.Address Book(Public)]

L P P

Touch [E-mail] or [Fax]

i IRERSE] (9 [ 852

Touch [New]

]

Touch [Name] to input name and Touch [OK]
H [£78] fi €78 # [OK]

Touch [Address] to input email or fax address and touch [OK]

HIFEFPH/IBE #93H @7 #90-> F# [OK]

Touch [Index] and select [Favorites] or other [Index] and touch [OK

B [N S P %3 [, F # OK]

Utility > E-Mail > New

No. ooog

T

Hame g

Index ] ete

11/17/2006 15:48

oo ﬁBC DEF GHI I JKL I HHO PI'JRS TUU M(YZ I elc

0002 tokyo
0003 0Sdka
0006 Nagoya
0007 fukuoka

Ney

Utility/Counter
L~
(O\ ‘

2 User Settings ]
3 Adninistrator Settings
4 Check Consumable Life

Utility > One-Touch/User Box Registration

1 Ccreate One—Touch
Dpestination > |
2 Create User Box 4

q Limiting Access
to Destinations

Utility > One-Touch/User Box Registration > Create One-Touch Destination

1 nddress Book ]
: T
3 E-Hail Settings 4

I

!

Utility > Create One-Touch Destination > Address Book

1 E-Hail ]
2 User Box

; [T
s R

I

5

Utility > E-Hail > Index

[ oot |

| ABC | DEF | GHI I JKL | HHO PfJRS | Ty 'HKYZ T
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Fax / Scan Function &g / ]ﬁﬁ:ﬁﬁrﬁﬁ:

1 p Fax/S Select desired destination(s>.
' ress [ ax Can] ®Fax can be sent at anv tine using kevpad.

}3&‘ [Fax/Scan] fiddress Book [DirecL Input | ["Job History | SeareR® | ofr-Hook

2. Find the destination by one-touch Index [ weegave |
S R Y 0 O
fry

| Group

Search
For fax function you can also press the _
H1 Sean Sottings | Original Settings, ganpypaganien

number key pad directly to input the fax
1040872008 19: 41
number Men 1007%

OPFRLEE i B P s g

[ Language selectinn"

If you want to fax the same document to multiple destinations, you can press the next destination button to
let you input the next destination fax number
O ST 7 (B B E IO T T (R T~ WE OB
foy

but tons

(Optional Fax Parts is needed)
(24 ke BB el | FRe)

[ cancer |J 0k

01:37
1002

3. Press [Start]
# [Start]
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Jﬁfﬁlﬁ’l}%ﬁ—’ Scan Setting

1.

29

Press [Fax/Scan]

}%‘ [Fax/Scan] Specify the settings.
Scan Setting ]ﬂ}‘,ﬁ]%i‘__
A. Original Type - Select original type

Scan Setilings

Basic
?lﬁ%ﬁjﬁ.’? - JEE‘E.%JF{WJ@EJ Original Type | SimplexsDuplex ' Resolution ' Scan Size
i W Auto
m_w_m, -
B. Simplex/Duplex - Select original 200000p1
single-sided or double-sided ——————
— L H . File Type Density
RS - ?t@ffgjﬁ@fp‘/%ﬁl ﬂ

C. Resolution — Resolution setting MuILi Page

R - DR

D. File Type — Change file format
HRKHE] - R o A
Multi Page- combine all scanned original data and save as a single file (can’t use if “JPEG” is select)

2F - PI%E gf@ﬁpﬁ@ (F o [k (7 JPEG T R=f™])

Page Separation - divide the scanned data at a specified page. (Specified by pressing number key pad)

VRL - PRIV T B IR RS (B SRR SV IR

E. Density — Change density
IR - ?t{é&ﬁf@

F. Color — Change color mode, B/W or Color

G. Separate Scan — Originals can be scanned separately and saved as a single file

SYRERBE - T (5 B (5 - hE

Original Setting ’F’lﬁ?}ﬁi‘%—_
Mixed Original — Multi-sized originals are loaded together into the feeder

FLEROR - TRPOANIRS, D PSRRI T IS TR

Find the destination by one-touch Index

Y- R (B R A

Press [Start]
¥ [Start]
The essentials of imaging
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Display and print the job history list fi =k

1. Touch [Job Details]

E iy

2. Touch [Send]

. N2
ﬁ [I’Elb_] Ho. [ P5Re==" [Destinatio OF e Urg.

3. Touch [Job History] Tokyo Sales : 1 Job COnplete
. Tokyo Sales H 1 .Job Complete

[[ﬁ% E IEI:‘;S'F] 9 Tokvo Sales 1 falated by
4. TOUCh [Comm LISt] Fukuoka Sales 10/24 1 Job Complete
o fukuoka, 5ales@  10/24 1 Job Complete
;LE[[ I{% _EIF f] 0523456789 10724 1 Job Complete

0saka Sales 10/24 1 [igdpbed by

5.  Select [Scan TX List] / [Fax TX List]
2 [ ESsi]/ B BESHA]
6. Select which report you want to print
ZERIH] ’1@%}2;5
> Activity Report FIRE
> TXReport [Hi=dA ] |
> RXReport 4 I A No. |Destination |vime”  |Fomd”  |Org. |Result \
7. Press [Start] Elobyessales 06 i Cactivity |

. 2 Dsaka Sales : . Report
i [Start] 3 Tokyo Sales

4 (saka Sales
5 Fukuoka Sales
& Tokyo Sales
7 Tokyo Sales

Deleted
JObE

GA2006  00:37

T4 Report

Ri Report

10/25/2006  11:12

30 The essentials of imaging



Remove Jammed Paper 7& [ 38 3% Nisfeed detecied,

Remove misfeed at circle.

* Remove misfeed at circle

T AT

»  Pull up the upper right side door release lever, and then open the upper right side door
FrRIEAT R fﬁﬂ Vi, i ITATIR

»  Open the door of the automatic duplex unit

ISR AR, TR et R

»  Open the door of the Bypass Tray
U= BRSPSyl R
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Change Toner Cartridge F {5545

*|f a toner is near empty > the screen will show a toner empty message

Ready Lo copy.

Toner is low. Replace when indicated.

Ready to copy. opics:

Toner is low. Replace when indicated. 1

Il0riginal Setting Original Type Application

nnnnnn

Density

[ ] ) ) [ 5] (5] (] iy e

Corner Staple L
Top Left U

Finishing 1 I Separate Scan | Auto Rotate OFF

Open the machine’s upper front door, pull the empty toner cartridge, then insert the new toner

7 BRI PRSI Al 2 5k pOmsiss 1,0 iomils

32
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Check and Print meter list S35~ HREFE &R

If Digital Doctor is not installed, please fax the meter report to 2565 2128 monthly
YNZLE J%’%Eﬁﬁ%ﬁf {?ﬁ?@ El§E 'P“?F%f 8= 2565 2128

1. Press [Utility / Counter]
f# [Utility / Counter]
2. Touch [Meter Count]

¥ [FHEEs]

Job List

. Copy
3. Touch [Check Details]
]
- Meter Count
4.  Touch [Print List] - sror ot Black |
- FUll Color
¥ [UEN |
single color |
5. Select paper tray
= 2 Color |
A Total |
6. Press [Start] - |
¥ [Start] 4

33
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Secure print ?Ié%ﬁﬁf’v}[[]iﬂ
Secure Prirt
1. Click [File] > [Print] = [Select Printer] 5|E'3““3 Prrt 1D o
##%] > [31H1] = {THIES] Password
2. Click [Preference] Max. 8

2 [{‘J’ﬁ’]
3. Click [Output Method] and select [ Secure Print] ,input ID and Password
U E URETIATY B ETIAT 101
4. Click [OK]
[l

Select the desired User Box to use or file document.
Use the keypad to input and specify the box number to use.

Recall a job from Copier

— = _ : .
KR HIBSEVRIES ﬂf; JIHIY & Era | e
| Hemory RX Annotation | Fax Retransmit
User Box User Box User Box
5. Press [User Box]

¥ [User Box] oo,

User Box
v wll ol <1 Pty

6. Press [System User Box]—> [ Secure print user Box]
- [Use/File]

A4
. Nah- 2% =10 7, FI i’ B E I ", Job List % Enter thfz ID for the secure p:’int .
G ORN G L tCo R CLIL - | f
%]

uuuuuuuu
nnnnnnnnnnn

7. Input ID and Password in the field of [Secure print ID]

and [Password]
N DO0O0DDDDDIDE
HSEFIE] 1D] A [HR] |7 DGR, T o]
SPﬂCe
[OK]

VD MI c[l KI I1IE:IE?/2[I[IE 11:"54 ‘W‘ W‘ |T‘ ]
8. Select desired file, press [Print] and then [ Start]

A (VA (SUAT] F I [Start]

1
1
1
1
1

A 4

= Select document(s) and then
choose the desired function.

Job List

Check Job
[ preview |

Selected Documents

Secure Print User Box

I Print

=

Detail

View

cancel |
\'U Ml GU Kl '112:12?/2005 1455 ancel |

34
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Print Envelope or custom size paper 3[|H]| I?ﬁ“&fﬁ HI N ~] 39

1.

Take paper away in the bypass tray and keep it empty.

PFRYHIEST S8 Fpuate L

?&“ﬂ?ﬁ,}“ Hji‘ﬂfi‘»l%% Printer Driver Setting

2. Open the file - click printer driver Hgoii:::om]ij:erzzjTze,mdg|s;p,c;;pm|wy|oml| -
e Favorte Setting Untitled - [ Add. |

o IR J?T@ MFee o EEAHIZAE .

3- CIICk [Preferences] Q This tab allows you to amange setting items as you like.
- - [] Do not show again

%’:’F}é []— J ?T] Original Orisntation Copies
4. Click [Original Size], select [Custom size] then ) [;ﬂ]

input Width and Length (e.g. : 110mm X

220mm) T

— -, =1 [ S adl

r+ [’FL% E\I._‘J ][ [E I 4_} ]#E[T 1 )F'L%ﬁljﬂj}%{ Fiieriomaton || (8 [ea T ===

HST (@ 120mm x 220mm) CEe JLmh | 58 )
5. Click [Output Size] select [Same as Original Size]

T [AEIR NS I R

[-I J ] [ [ill: I—I:I Flﬁ J ] Custom Srze‘;ett'lngs ‘ M|
6. Press [OK]
Width Lnit
[FEJ 2% = mm[90.0..311.1] @ mm
inch

7.  Place the envelope or custom size paper on the bypass tray (Face %; mm [139.7..1200.0]

Down)

= W[’ﬁﬁ ORI AR IR S Y HIBS = 2 (O )

[ ok [ camcel ][ Defauk | [ Hep

8. Press [Complete] - _

A ]

35
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Banner Paper Printing J|[H[=A%F=V @ pLAE -

Banner paper size: (Width) 210 - 296mm / (Length) 457.3 —1200mm
Ak N FU 210 - 296mm / & 457.3 -1200mm

M Prepare printing on Banner Paper
5’?? b J[HIFAEE] v HI A0 J’-’sfﬂ*‘*ﬁJ

Job List i To activate banner printing, choose [Allowl.

L. Press [Utility/ Counter] N
#¥ [Utility/ Counter] s
2. Touch [6. Banner Printing] oo |

6. RAFH]

oK |

01/05/2007  17:42
Memory 1007

3. Touch [Allow] - then touch [OK]
Z [Allow “e5¥] - £ [OKfEE]

Printer Driver Setting S i

= A Ve -—
AW @ ‘l_%w l_* &-[/ % ﬁ’, 2 My Tab |Bam: | Layout I Finish | Cover Mode | StampComposition I Quality | Other ‘
|

7| Favorite Setting Untitled -

? This tab allows you to amange setting tems as you like.

More Details [C] Do net show again

Copies
1 = [1..9993]

4.  Open the file » Click printer driver
PRI [ A SRR IR

@ Offset

5. Click [Preferences] = R ¥ e
B [PI] G 0G| Jeewm | B f
B 8 Vg = 1
) o ) ) . Porte fomaton || (] Ey b D ‘
6. Click [Original Size] select [Custom size] then
(% [ ®ma |[ =9 |
input Width and Length(e.g. : 296mm x 1143mm) custom sizz setings R -
G [JFLﬁW N ] [E IEN] ]ﬁ E ELIE IR ] Width Unit
(f: 296mm x 1143mm) = gmesiy ® o
Length ) inch
1143 =) mm [139.7..1200.0)
7.  Touch [OK]
7 el
36 [ - oKk || Cancei | [ Defaut | [ Hep | |
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Banner Paper Printing J|[H=A%F= @ pbAE S

10.

11.

12.

37

Specify the desired settings - then touch [OK]
F IR O B VR Y

Feed the banner paper to Bypass Tray

A SRR AT

When printing is finished, touch [Exit]
SIEIE RS L=z

Touch [Yes]
£ [RL]

Then touch [OK] to finish banner-printing

function

FORERD TR (e LR R

Touch [Exitl to quit banner printing.

B
[ Exit J

vl ekl 0 !

| JobList | C fire you sure you want to quit banner printing?

Neme | Status

)
-
il

vl vl cll ke
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Using External Memory fﬁﬁ']%fﬁﬂ?ﬁl‘l‘ﬁiﬁ

USB Port

Print from External Memory (&} E{?l‘ﬁgﬁﬁ;‘? H]

>  Press [User Box]—>[System user box] = [External Memory]->[Use/file] > Select file>[Print]>[Start]
¥ [User Box]2>[5ak] > [%%?l‘l‘ﬁa‘ﬁﬁ‘]é[fﬁl BRR > E B HIpus >[I > [Start]

Scan to External Memory & Z] 9 f’g’f%l‘l‘ﬁiﬁ
L | |
(Must enable in Admin mode first o< J72E! L i =)o)

»  Press [User Box]—>[Save document] - [External Memory]—> [Start]
f¥#[User Box]> [ %] > [t %FEI'I'EL%] ~>[Start]

38
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X R AR ) F L

Konica Minolta Business Solutions (HK) Limited
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o L i

New Product and Sales Enquires

ﬁBF‘FJ%?EE»F}L Particulars Frifefis New Contract No.
ﬂﬁ;ﬁ%[ Marketing Division
> il EE G0 Sales Hotlines Fye Tel : 2565 2111

RE gl Email: bhkg sales@bhk.konicaminolta.hk

| Technical Service Division

> REfZEGELRepair Hotline
n Z :jj ok Fﬁ#[,yakﬂél'?q@?j
Repair Services of MFPs

IR

= Tel :2565 2176
(B1dr Fax:2856 1024

ﬁﬁ%’%‘ﬁ[ Technical Service Division

> R pERGa
Imaging Support Group
AR IR

Software and Network Support

lELfI;II: B5= Tel :2565 2178

F?”J | Technical Service Division
> & RUERsL Customer Service Hotlines
[ | eIty =l
Maintenance Agreement
u ;a%gﬁk[[/gfﬂf[, 5
New Customer Product Training
u %’iﬁﬁ‘,%ﬂ Invoice Enquiries
B 7R Meter Reading
u F —F’[—Iz"lﬁi];}%
AR S O R VRIS
'}y U FI /\Ff\vjl:l: ‘}’;‘E IHFJFﬂiF/’%f o )
Meter Reading Reporting Service for
Telephone System
(The service initially covers the black
and white copier ONLY)

e Tel 12565 2190
{8 Fax:2565 2128

:Eg

7 Tel :2565 8181
O RIE TS o7 - L S A FJE& “r

ek F AR o (I & TR B
e o A

Tel: 2565 8181
Press “2”, then press “3” and “1”
”FET—EB Email: bhkg_csmeter@bhk.konicaminolta.hk

Jg#55%] Technical Service Division
> F'Jff[l, fHEEvEL Order Section Hotlines
Lt e TR
Ordering of Consumable Products
(Toners, Paper etc)

e Tel: 12565 2139
[ dr Fax :2565 7613
”F‘q*‘?[f Email: bhkg_csorder@bhk.konicaminolta.hk

FAPE
> FIGE A
Statement Enquiries

B5= Tel :2856 4710
Fax :2516 9177

Iﬁ‘{ﬂ I

= =& Administration Division
> E PR AU PR

Other Suggestions & Comments

Fh'ﬁf' ;25658181 xfF “0”
Tel: 2565 8181 then press “ 0 ”

&

Online Support Services

http://konicaminolta.com.hk/bt/chi/form

40
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